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Chapter 1
User manual

1.1 Introduction

The aim of the Math2mat software is to automatically generate a VHDL description
of a mathematical function using floating point operators. It also generates a full Sys-
temVerilog testbench that allows to validate the hardware description by comparing
it to the initial mathematical description. The initial description corresponds to the
Matlab/Octave syntax, and allow operations such as addition, subtraction, multipli-
cation, division, and structures such as if/then/else and for loops.

The main features of Math2mat are:

• Editor for typing Octave code

• Dynamic code analysis, during typing

• Generation of synthesizable VHDL code

• Floating point operations

• SystemVerilog testbench generation

• Fully automated test suite for the generated code

• Graphical interface with internal structure viewing

As the software is still under development, don’t hesitate to submit a wish on the
Wiki page of Math2mat:
http://www.tobecompleted.org

1.1.1 Conventions

The following conventions apply in this manual:

• Octave code is presented in this format

• VHDL code is presented int this format

1
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• Menu selection is shown This→Way

• Files and folders are shown /like/this

• File content is shown in a box that also highlights the filename:

Various source code;
And more;

filename.ext

1.2 Requirements

Math2mat has been developped in Java, with the Eclipse framework. The release
should be self-contained, and should run on Windows and Linux. The following
systems have been tested:

• Windows XP

• Windows 7

• Linux Ubuntu 10.10

VHDL code can be generated without additional software.
The software allows to view the internal representation of the structure that will

lead to the VHDL generation. This view, far from being user-friendly, can be useful
for developers, and is generated using dot. This software can be downloaded from

http://www.graphviz.org/

1.2.1 Simulation

For validating the generated files, Octave and QuestaSim are required. Octave is an
open-source software closely related to Matlab, as the accepted syntax is the almost
the same. Octave can be downloaded from

http://www.gnu.org/software/octave/
QuestaSim is an HDL simulator, provided by MentorGraphics. It allows simula-

tion of SystemVerilog designs and testbenches. It can be purchased from
http://www.mentor.com/
Math2mat has been validated with QuestaSim versions

• 6.5

• 6.6

Tests were run with these versions, but the system should work with further ver-
sions of QuestaSim. Previous versions of QuestaSim are not supported, as they do
not fully accept SystemVerilog constructs. One of OVM or UVM methodology is also
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required for correct simulation of the testbench. The files of the methodology are
supplied by Math2mat, but the simulator needs to support these features.

Please not that for Linux users, dot and Octave can usually installed with the help
of the software manager.

1.2.2 Ubidule tests

Math2mat allows to automatically generate a bitstream for a Xilinx Spartan3 embed-
ded on a board called ubidule. The automatic bitstream creation requires Xilinx ISE
to be installed. Tests have been conducted with version 12.2, but further versions
should work. ISE can be retrieved by visiting the Xilinx website:

http://www.xilinx.com

1.3 User’s guide

Math2mat provides a graphical interface as show in figure 1.1. Command line oper-
ations using a subset of the Java classes are also possible, and are documented in the
developer guide.

1.3.1 Project management

A Math2mat project consists in a .m file that contains the mathematical source code,
and in a certain number of parameters.

A project file has the extension "m2m", and contains a XML description of the
entire project. This only file describing the entire project, the .m file is automatically
regenerated by the tool if it is missing.

Standard Open, Save and Save as commands allow to open and save the project.
Creation of a project can be executed in two ways: Through an empty project, or by
importing a .m file.

1.3.1.1 Empty project creation

The creation of an empty project can be triggered through menu File→Create empty
project. In that case, a template .m file is generated, and contains the following code:

% Here is a simple function that adds two numbers
% Feel free to modify it

function s=<FileName>(a,b)
s=a+b;

endfunction

<FileName>.m

Where <FileName> is the name of the project.
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Figure 1.1: Math2mat graphical interface

1.3.1.2 Project creation from .m

The creation of a project from an existing .m file allows the user to select the name
of the project, and then the .m file to import. The .m file is copied into the project
directory, and so the original one won’t be modified by Math2mat.

1.3.1.3 Folder validation

There is a possibility to launch the validation on a folder by selecting Tools→Validate
projects. It recursively open every project found in the hierarchy, and launch the full
verification process on the projects. At the end, a report in the console view indicates
if errors were found.
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1.3.2 Folders structure

During the creation of a new Math2mat project, a folder with the name m2m_<funcName>
is created in the same directory as the project file (<funcName> is the function name).
Inside this folder, a couple of other folders are created:

/
m2m_<funcName>

report ...........Contains the reports from simulation.
src_VHDL......... Contains all the VHDL files generated by the software

wrappers .....Contains generic wrappers for the generated system
M2M_Test .....Contains VHDL files for the ubidule implementation

src_SV ...........Contains all the SystemVerilog files generated for the
simulation

ovm ............Contains modified OVM source files
ovm_original Contains original OVM source files
uvm ............Contains original UVM source files

src_m2m ......... Contains the Octave source file
src_OCT ......... Contains all the other Octave files needed for generat-

ing the reference outputs
sim ...............Contains the script that will be executed by QuestaSim

for the simulation
comp .......... Will contain the compiled simulation files
iofiles ...... Will contain the input and expected output data files

generated by Octave
ubidule ......... Contains the files needed for testing the system on a

real ubidule hardware.

1.3.3 Mathematical grammar

The source file of a Math2mat project consists in a file that must conform to the Octave
language. To date, the parser accept a subset of the language :

• Calculus operator (+,-,*,/,
√

x) ;

• Logical operator (and, or, =, 6=, <, >, ≤, ≥) ;

• Loop “for” ;

• Conditional structure (if/then/else/elseif) .

A function accepts any number of inputs and outputs.
The following code illustrates a simple function with 2 inputs and 1 output:

function s=example01(a,b)
s = a*2;
s = s+b;

endfunction

example01.m
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The following code illustrates the if/then/else structure:

function s=example02(a,b)
if (a<b)

s = a*2+b*3;
else

s = a*2-b*3;
end

endfunction

example02.m

The following code illustrates a function with 2 inputs and 2 outputs, as well as a for
loop:

function [s1,s2]=example03(a,b)
s1 = 0;
for i=1:1:10

s1=s1+a;
end
s2 = s1+b*4;

endfunction

example03.m

1.3.3.1 EBNF

Here is the complete EBNF syntax supported by the parser.
entry : : = { pramga } , funct ion ;
a f f e c t : : = ident , [ tab_ind ] , ’= ’ , e x p r _ l v l 1 , [ ’ ; ’ ] ;
body : : = { i n s t r u c t i o n } ;
cmp_op : : = "==" | " != " | ’< ’ | ’> ’ | "<=" | ">=" ;
e x p r _ l v l 1 : : = expr_lvl2 , { ( ’+ ’ | " .+ " ) , e x p r _ l v l 2 } ;
e x p r _ l v l 2 : : = expr_lvl3 , { ( ’− ’ | " .− " ) , e x p r _ l v l 3 } ;
e x p r _ l v l 3 : : = expr_lvl4 , { ( ’∗ ’ | " .∗ " ) , e x p r _ l v l 4 } ;
e x p r _ l v l 4 : : = expr_lvl5 , { ( ’/ ’ | " ./ " ) , e x p r _ l v l 5 } ;
e x p r _ l v l 5 : : = func_var , { ( " ∗∗ " | ’^ ’ ) , func_var } | ’ ( ’ e x p r _ l v l 1 ’ ) ’ ;
func_param : : = func_var , { ’ , ’ , func_var } ;
func_var : : = ( [ ’− ’ ] , ( ident , [ ’ ( ’ , func_param , ’ ) ’ ] | number )

| ’ [ ’ , [ [ ’− ’ ] , number , { ’ , ’ , [ ’− ’ ] , number } ] ) ;
func t ion : : = funct ion_begin , body , function_end ;
funct ion_begin : : = " funct ion " , ( ’ [ ’ , ident , { ’ , ’ , ident } ’ ] ’ | ident ) ,

"=" , ident , ’ ( ’ , param , ’ ) ’ ;
function_end : : = ( " end funct ion " , ident , ’ ; ’ | " endfunction " [ ’ ; ’ ] ) ;
i f t h e n e l s e : : = " i f " , ’ ( ’ , logexpr , ’ ) ’ , [ " then " ] , body ,

{ " e l s e i f " , logexpr , body } , [ " e l s e " , body ] ,
[ " end " | " endi f " ] ;

ident : : = char , { d i g i t | char | ’ _ ’ } ;
i n s t r u c t i o n : : = a f f e c t | loop | i f t h e n e l s e | op_switch | not_instruct ion_cmd ;
logexpr : : = logterm , [ log_op , logexpr ] ;
logterm : : = l o g f a c t o r , [ cmp_op , logterm ] ;
l o g f a c t o r : : = [ ’ ! ’ ] , ( func_var | ’ ( ’ , logexpr , ’ ) ’ ) ;
log_op : : = " or " | " and " ;
loop : : = loop_begin , body , [ " end " | " endfor " ] ;
loop_begin : : = ’ f o r ’ , ident , ’= ’ , func_var , " : " ,

func_var , [ ’ : ’ , func_var ] ;
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not_instruct ion_cmd
: : = ( " p r i n t f " | " e r r o r " ) , ’ ( ’ , any_str ing , ’ ) ’ , [ ’ ; ’ ] ;

number : : = d i g i t , { d i g i t } , [ ’ . ’ , d i g i t , { d i g i t } ] ;
op_switch : : = " switch " , func_var , { " case " ,

( func_var | ’ [ ’ , func_var , { ’ , ’ , func_var } ) ,
[ ’ , ’ ] , body } , [ " otherwise " , [ ’ , ’ ] , body ] , " end " ;

param : : = ident , { ’ , ’ , ident } ;
pragma : : = "%m2m" , ident , ’ : ’ , ident ;
tab_ind : : = ’ ( ’ , number , ’ ) ’ ;

char : : = ’ a ’ | ’ b ’ | ’ c ’ | ’d ’ | ’ e ’ | ’ f ’ | ’ g ’ |
’h ’ | ’ i ’ | ’ j ’ | ’ k ’ | ’ l ’ | ’m’ | ’n ’ |
’ o ’ | ’p ’ | ’ q ’ | ’ r ’ | ’ s ’ | ’ t ’ | ’u ’ |
’v ’ | ’w’ | ’ x ’ | ’ y ’ | ’ z ’ |
’A ’ | ’B ’ | ’C ’ | ’D ’ | ’E ’ | ’ F ’ | ’G ’ |
’H’ | ’ I ’ | ’ J ’ | ’K ’ | ’L ’ | ’M’ | ’N’ |
’O’ | ’P ’ | ’Q’ | ’R ’ | ’ S ’ | ’T ’ | ’U’ |
’V ’ | ’W’ | ’X ’ | ’Y ’ | ’Z ’ ;

d i g i t : : = ’ 0 ’ | ’ 1 ’ | ’ 2 ’ | ’ 3 ’ | ’ 4 ’ |
’ 5 ’ | ’ 6 ’ | ’ 7 ’ | ’ 8 ’ | ’ 9 ’ ;

1.3.4 Views

Different views are proposed to the user, the main one being the editor in which
the mathematical code has to be written. From this code, a flat/tree view allows to
visualize the internal representation of the function, and a dynamic view presents the
hardware structure that can be generated.

1.3.4.1 Editor

A text editor allows to edit the mathematical code. It highlights the text following the
Octave syntax.
The editor executes a live parsing every time the user modifies the text. The error
messages are displayed at the bottom of the main view, and allow to rapidly verify
the code. Moreover, if the dynamic view is shown, then the content of this view is
dynamically modified if the code corresponds to a correct syntax.
Using the Edit menu, the following actions can be processed on the text:

• Execute Undo/Redo actions

• Cut the selected text and put it into the clipboard

• Copy the selected text and put it into the clipboard

• Paste the content of the clipboard

• Delete the selected text

• Select the entire text

• Toggle the comments on the selected text

• Comment and uncomment the selected text
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1.3.4.2 Dynamic view

The dynamic view corresponding to the source code can be shown by selecting the
menu View→Dynamic view. It then contains a graphical description of the hard-
ware that will be generated. This view is dynamically regenerated every time the
source code changes, i.e. every time the code is valid.
Through this view, moving the pointer on the graphical objects displays their prop-
erties in the Properties view.
The following code will create the view presented in figure 1.2.

function s=test(a,b,c)
if (a>b)

s=a-b+c;
else

s=b-a+c;
end

endfunction

test.m

Figure 1.2: Dynamic view showing the hardware structure

Different properties are displayed and can potentially be changed, depending on the
kind of object:

View outside function The type of floating point operations can be chosen: 32 or 64
bits.

Red square A red square represents an internal signal. It can be monitored or not. If
checked, then the state of this signal is verified during simulation.

Operator An operator is a basic block that performs computation. Different imple-
mentations are proposed and can be chosen by the user. When selecting a block,
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it is also possible to apply this change to all operators executing the same com-
putation.

Multiplexer A multiplexer is used when if/then/else statements are present in the
source code. Putting the pointer on a multiplexer highlights in blue the sig-
nals necessary for the condition calculation. It is also possible to monitor the
condition of the multiplexer.

For increment In a "for loop" block, the increment is represented by a rectangle.

1.3.4.3 Flat/tree view

Math2mat offers the possibility to view the state of the internal structure. This struc-
ture is created during the code parsing, and is then manipulated in order to prepare
the VHDL code generation. A standard user should note really need to open this
view, letting this to developers. The tree view corresponds to the state of the struc-
ture after parsing, while the flat one represents its state before code generation.
These view requires "dot" software to be installed (cf. section 1.2, page 2). Math2mat
generates a dot file called fname_flat.dot (or fname_tree.dot) that is then pro-
cessed by dot to create a png file called fname_flat.png (or fname_tree.png) .
This last file is then open by Math2mat. The *.dot and *.png files can be found in the
/src_m2m folder. Figure 1.3 illustrates the schematics corresponding to the flat view
of the following code:

function s=adder(a,b)
s=a+b;

endfunction

adder.m

Figure 1.3: Internal structure corresponding to the operation s = a + b;

As the schematics generated can be very big, it is often easier to open them using a
traditional image viewer instead of using Math2mat.

1.3.4.4 Messages view

At the bottom of the graphical interface, a message view corresponding to a console
displays useful information in order to let the user know what happens.
This information depends on the type of processing the software is doing:
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• Editing. Compilation errors or warnings

• Octave code generation. Messages about what files are created

• Simulation. Messages retrieved from QuestaSim

• Ubidule testing. Messages showing what happens during the synthesis, place-
ment/routing processes, and during the test on the real hardware

• Always. Potential internal errors

1.3.5 Code generation

Code generation can be executed by selecting the menu Tools→Generate VHDL.
The VHDL files are put in /src_VHDL. The description of the files structure and
implementation can be found in another document.

1.3.6 Verification

Math2mat being able to generate VHDL code, checking that this code really does
what it should allows to better trust the tool. For this purpose, simulation can be
automatically launched in order to verify the generated system functionality. The
testbench is generated in the folder src_SV, and is composed of SystemVerilog files.
QuestaSim is required for the simulation of these SystemVerilog files, and is launched
by Math2mat. The Configure...→External Tools menu allows to specifiy where the
vsim executable is located, in case it is not accessible through the common path
search. As Octave is also required to generate reference date files, it should also been
reached by the common path or located through the same menu.
The verification is done in two phases:

1. Firstly reference data are generated by Octave;

2. Secondly SystemVerilog takes advantage of the references to simulate and ver-
ify the system behavior.

Simulation settings can be chosen through the menu Configure→Simulation. It
opens a tab in which the settings can be entered. Figure 1.4 illustrates this view.
The following settings can be chosen:

• The calculation precision defines how error calculations are detected. It corre-
sponds to the number of bits of the mantissa that can differ between the ex-
pected and the real results;

• The number of samples to test. One sample corresponds to a single call to the
function;

• The system frequency is the frequency at which the system should work;

• The input frequency corresponds to the rate at which input data should be ap-
plied to the system;
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Figure 1.4: Simulation settings tab

• The output frequency corresponds to the rate at which output data should be
retrieved;

• The period of inactivity allows to automatically end the simulation if no activity
is detected on the output for a certain number of clock cycles.

The three frequencies are used in order to more or less stress the system. For each
input of the system (each input variable), a valid input is applied at a random rate
with probability input f requency

system f requency . For each output of the system (each output variable),

a ready signal is applied at a random rate with probability output f requency
system f requency .

The new settings are set when pressing on the Apply button, and will also be stored
in the project file.

1.3.6.1 Reference generation

Octave is used to generated files describing the inputs and files in which the ref-
erence output values are stored. All these files are stored in /sim/iofiles, and
have names being file_input1.dat, file_input2.dat, ... for the input, and
file_output1.dat, file_output2.dat for the ouptut. The number corresponds
to the place of the input/output in the Octave source code. The calculation is per-
formed using the source file edited in the Math2mat editor. However, if internal
variables have to be monitored, then the octave file is regenerated in order to create
data files for the internal variables. In that case, the menu Tools→Test regenerated
Octave code allows to validate the regenerated code, ensuring that its functionality
is the same as the original file.
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1.3.6.2 Simulation

Simulation is handled by QuestaSim. QuestaSim is launched in batch mode and exe-
cutes the script that was previously generated: /sim/simulation.do. The output
of the simulation is displayed in the console view, the end of the message allowing to
observe if the simulation went well or not. The last lines look like this:

Successful Unsuccessful

M2M_WARNING : 0 M2M_WARNING : 0
M2M_ERROR : 0 M2M_ERROR : 1000
M2M_FATAL : 0 M2M_FATAL : 0

If by any unlucky day the simulation does not go well, then QuestaSim can be used
with its graphical interface. The user only needs to go to the /sim directory and to
launch the script simulation.do.

1.3.7 Ubidule tests

Simulation allows to trust the generated files in terms of functionality. There are
guaranties that the VHDL description is synthesizable, and tests with real hardware
can be done. For this purpose, the software can validate the description using a
ubidule (cf. figure 1.5).
This feature requires a ubidule to be set up with a server running. It is therefore not
available to all users at any time.

Figure 1.5: Picture of a ubidule board (top and bottom)

A ubidule embeds an ARM processor running embedded Linux, and a Xilinx Spar-
tan3, as shown on figure 1.6.
In this context, Math2mat can automatically perform validation on the real hardware
by performing the following actions:
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Figure 1.6: Schematics of a ubidule

1. Generate VHDL files that instantiate the mathematical function and adds ev-
erything needed to work on the board;

2. Generate scripts for launching the Xilinx tools

3. Launch Xilinx ISE for synthesis, placement and routing

4. Launch Xilinx Impact for generating the bitstream

5. Connect to a remote server that runs on the ubidule

6. Send the bitstream to the server

7. Send input data

8. Retrieve output data

9. Compare the calculation output to the expected ones

Through the GUI menus, the following actions can be launched:

• The menu Tools→Ubidule test→Launch entire ubidule process launches this
entire process.

• The menu Tools→Ubidule test→Launch ubidule files generation launches
steps 1 to 4.

• The menu Tools→Ubidule test→Launch ubidule verification launches steps 5
to 9.

The VHDL files for the ubidule implementation are generated in /src_VHDL/M2M_Test/,
while the scripts are generated in /ubidule/.
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1.3.8 External tools

As many different tools are required for the different actions the software can per-
form, a dialog allows to specify some information about these tools, as shown in
figure 1.7.

Figure 1.7: External tools properties dialog

As already mentioned, no external tool is required to simply generate a VHDL de-
scription. Octave and QuestaSim needs to be accessible for verification, Xilinx ISE
only for ubidule tests, and dot for visualizing the internal structure.
For these four tools, by default their name is proposed by Math2mat. If they are not
accessible through the path, then the user can specifiy the location of the executable,
as shown in figure 1.7 for Vsim (the executable for QuestaSim).

For ISE, only the directory where ISE is installed should be set, not the executable
itself.
Two combo boxes allow to specify general settings for the simulation. The simulation
files lets the user choose to use OVM, UVM, or modified OVM files. The only changes
during simulation are the way messages are displayed in the console. The prefix will
be:

Simulation files Prefix

OVM M2M_ERROR : 0
Original OVM OVM_ERROR : 0
Original UVM UVM_ERROR : 0
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If the user needs to perform simulation using the QuestaSim Gui by executing the
script /sim/simulation.do, then it is better to use the original options, as the
errors will be identified by QuestaSim.
The simulator allows to specify what version of QuestaSim is installed on the com-
puter. Depending on the version (up to 6.5 or from 6.6), different SystemVerilog code
is generated in order to attain internal signals in the VHDL hierarchy.
The last two fields are required for the ubidule tests. The license for the Xilinx tools
has to be specified, as well as the IP address of the ubidule on which the testing server
is running.

1.4 Tutorial

This tutorial shows you the steps required to create a new project, generate the VHDL
code, and simulate it. If something goes wrong with the steps, it is probably because
Math2mat does not find the external tools. In that case messages should appear, and
you’ll be able to specify their location with the menu Configure...→External tools.
So, here are the steps:

1. Select the menu File→New empty project;

2. In the dialog, choose the name of the project. You should create it in an empty
directory, as it will be populated with the directories of Math2mat;

3. The new file contains a function that performs an addition;

4. Open the dynamic view (View→Show dynamic view) to observe the kind of
digital system that will be generated;

5. Feel free to modify the function, but at least you can start with the simple adder;

6. To generate the files and simulate them, select the menu Tools→Run all, or

click on the icon;

7. And there you are... Too simple, no?

8. Add a little bit of complexity to the function, making it look like this:

function s=<FileName>(a,b)
s=a*b+b;

endfunction

<FileName>.m

The dynamic view should now look like this:
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9. Move the pointer onto different places of the dynamic view. You can observe
the properties of the objects;

10. Click on one of the red squares, and select Monitor mode in the property view.
It will then monitor this signal during the next simulation;

11. Click on the icon to generate and simulate the new design.

1.5 Commands

This section lists all the commands accessible from the different menus. A reference
allows to rapidly go to the section in which more details about the command can be
found.

1.5.1 Menu File

File→New empty project Section 1.3.1, page 3

Create a new empty project. The user is asked to choose a directory and a name for
the project. The .m file is automatically created and corresponds to the name of the
project. A function template is also written into the file, in order the names to match.
This function is

% Here is a simple function that adds two numbers
% Feel free to modify it

function s=<FileName>(a,b)
s=a+b;

endfunction

<FileName>.m
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Where <FileName> is the name of the project.

Create new project from .m file Section 1.3.1, page 3

Create a project with an initial source code file copied from an existing one.

Open Section 1.3.1, page 3

Open a Math2mat project file.

Save Section 1.3.1, page 3

Save the current project, as well as the .m file

Save as... Section 1.3.1, page 3

Save, with a new name, the current project.

Exit

Quit the application.

1.5.2 Menu Edit

Undo Section 1.3.4.1, page 7

Undo the last action.

Redo Section 1.3.4.1, page 7

Redo the actions that have been undone.

Cut Section 1.3.4.1, page 7

Cut the selected text and put it into the clipboard.

Copy Section 1.3.4.1, page 7

Copy the selected text into the clipboard.

Paste Section 1.3.4.1, page 7

Paste the content of the clipboard into the text editor.
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Delete Section 1.3.4.1, page 7

Delete the selected text.

Select all Section 1.3.4.1, page 7

Select the whole text of the current editor.

Toggle comment Section 1.3.4.1, page 7

Toogle the comments for the selected lines.

Comment Section 1.3.4.1, page 7

Comment the selected lines.

Uncomment Section 1.3.4.1, page 7

Uncomment the selected lines.

1.5.3 View

Show the flat view Section 1.3.4.3, page 9

Show the flat view of the internal structure in the form of a .png file loaded in the
GUI.

Show the tree view Section 1.3.4.3, page 9

Show the tree view of the internal structure in the form of a .png file loaded in the
GUI.

Show the dynamic view Section 1.3.4.2, page 8

Show the dynmic view corresponding to the mathematical code.

Clear the console

Simply clear the console view.
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1.5.4 Tools

Generate VHDL Section 1.3.5, page 10

Generate the VHDL files corresponding to the Octave code.

Launch test generation (with Octave) Section 1.3.6.1, page 11

Generate the input/output data files by launching Octave.

Launch Verification Section 1.3.6, page 10

Start the verification using QuestaSim. It requires the VHDL and the input/output
files to be up to date.

Run all Section 1.3.6, page 10

Run the entire flow: VHDL generation, input/output files generation, and simula-
tion.

Test regenerated Octave code Section 1.3.6.1, page 11

This command allows to verify that the regenerated Octave code executes the same
functionality as the original one.

Validate Projects Section 1.3.1.3, page 4

Allow to recursively validate all the projects found in a directory.

Launch ubidule files generation Section 1.3.7, page 12

Launch the ubidule files generation:

1. Generate VHDL files that instantiate the mathematical function and adds ev-
erything needed to work on the board;

2. Generate scripts for launching the Xilinx tools

3. Launch Xilinx ISE for synthesis, placement and routing

4. Launch Xilinx Impact for generating the bitstream

Launch ubidule verification Section 1.3.7, page 12

Launch the ubidule verification, taking into account that the files have been previ-
ously generated:
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1. Connect to a remote server that runs on the ubidule

2. Send the bitstream to the server

3. Send input data

4. Retrieve output data

5. Compare the calculation output to the expected ones

Launch entire ubidule process Section 1.3.7, page 12

Launch the entire ubidule test process:

1. Generate VHDL files that instantiate the mathematical function and adds ev-
erything needed to work on the board;

2. Generate scripts for launching the Xilinx tools

3. Launch Xilinx ISE for synthesis, placement and routing

4. Launch Xilinx Impact for generating the bitstream

5. Connect to a remote server that runs on the ubidule

6. Send the bitstream to the server

7. Send input data

8. Retrieve output data

9. Compare the calculation output to the expected ones

1.5.5 Configure...

External tools Section 1.3.8, page 14

Configure the external tools properties.

Simulation Section 1.3.6, page 10

Modify the settings for the simulation.

Optimization Section 1.3.5, page 10

Modify the settings for the optimization.
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1.5.6 Help

About Math2mat

A standard About dialog, that displays the version number, as well as the way to to
contact the developing team and some information about Math2mat.

Key assist...

Allow the user to view the shortcut keys.
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Chapter 2
Blocks

2.1 Introduction

2.1.1 Purpose of the project

The base cells of Math2mat project are to perform basic operations such as +, -, *, /,
sqrt. The project’s goal is to optimize the speed of operations, that’s why a pipelined
version of these operators should be considered. Cells must manipulate floating
point numbers. IEEE standard 754 has been imposed (single and double precision).

2.1.2 IEEE 754 format

IEEE 754 is a standard for the description of floating point numbers. Single precision
format includes 32 bits, 1 for the sign, 8 for the exponent and 23 bits for the mantissa.
Double precision format includes 64 bits, 1 for the sign, 11 for the exponent and 52
bits for the mantissa.

2.1.2.1 Single precision format

31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

s exponent mantissa

With the standard IEEE 754, the equation 2.1 allows to compute the real number.

number = (−1)s ∗ 1.mantissa ∗ 2(exponent−127) (2.1)

2.1.2.2 Rounding

The IEEE 754 defines four rounding modes :

• Round toward +∞

• Round toward −∞
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• Round toward 0

• Round to nearest

For the math2mat project, we only implemented one rounding mode, round to near-
est. This rounding is done by checking the value of the 24th bit generated during
a computation of the mantissa in single precision. If this bit is ’1’, the mantissa is
incremented by ’1’, otherwise she’s unchanged.
Example :

1.1100...101 round−−−→ 1.1100...11

1.1100...100 round−−−→ 1.1100...10

2.1.2.3 Exceptions

Type Exponent Mantissa

Zeros 0 0

Denormalized numbers 0 different to 0

Normalized numbers 1 to 2e − 2 any

Infinity 2e − 1 0

NaNs 2e − 1 different to 0

Table 2.1: Exceptions of IEEE 754 format

Math2mat project doesn’t handle the denormalized numbers described by the IEEE
754 standard.

2.1.3 Cell interface

The interface of base cells (+, -, *, / and sqrt) was defined as follows (for square root,
only one input of data) :
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24 CHAPTER 2. BLOCKS

Signal : Description

D1_i : Data 1 (IEEE 754 format).
D2_i : Data 2(IEEE 754 format).
valid_i : When high, the inputs are valid.
clk_i : System clock.
reset_i : System reset.
stall_i : When high, stop the operation (!enable).
m_g : Generic constant, defines the computation in single (m_g=32) or

double (m_g=64) precision.
pipe_g : Generic constant, defines the combinatorial (= 0) or pipelined (!= 0)

version.
latency_g : Generic constant, defines the duration of the operation for the com-

binatorial version.
type_g : Generic constant, defines the algorithm used for the operation.
wValid_g : Generic constant, defines the width of the signal valid_i
m_o : Result of the operation in floating point (IEEE 754 format).
valid_o : When high, the result is valid.
ready_o : When high, a new computation can be done.

Figure 2.1 illustrates the ports of a basic cell.

m_o

reset_i

clk_i

pipe_g

latency_g

D1_i

D2_i

valid_i

valid_o

m_g

stall_i

m_g

type_g

m_g

m_g

wValid_g

ready_o

wValid_g

wValid_g

Figure 2.1: Basic cell interface

Even if the component allows to set generically the width of data bus, some algo-
rithms have so far been implemented in single precision, ie for a fixed bus width
of 32 bits.
For some operation, it’s useful to have a cell, which one must delay a computation
that must be synchronized with another, so the next block was created. It’s a shift
register (delay_g = nb of registers) where each output m_o(i) has its validation

Math2mat User Manual c©HES-SO // ISYS



2.1. INTRODUCTION 25

signal valid_o(i), as shown in figure 2.2.

Delay

m_o

reset_i

clk_i

delay_g

m_i

valid_i

valid_o

 m_g

wValid_g

stall_i

m_g

wValid_g

wValid_g

 m_g

Figure 2.2: Delay component

2.1.4 Floating point algorithms

2.1.4.1 Addition / Subtraction

1. Take the largest exponent (= exponent of the result).

2. Shift the mantissa of the smallest number, the gab is the value of the difference
of the exponents.

3. Addition / Subtraction of the mantissas.

4. Normalization of the result : mantissa between [1 : 2[, modification of the ex-
ponent if necessary

5. Round to nearest.

2.1.4.2 Multiplication

1. Addition of the exponents.

2. Multiplication of the mantissas.

3. Round to nearest.

4. Normalization of the result : mantissa between [1; 2[, modification of the expo-
nent if necessary.

2.1.4.3 Division

1. Subtraction of the exponents.

2. Division of the mantissas.
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3. Round to nearest.

4. Normalization of the result: mantissa between[1; 2[, modification of the expo-
nent if necessary.

2.1.4.4 Square root

1. Division by 2 of the exponent.

2. Square root of the mantissa.

3. Round to nearest.

4. Normalization of the result : mantissa between [1; 2[, modification of the expo-
nent if necessary.

2.2 VHDL description of the base cells

2.2.1 Top level

The top level of a base cell (Add2, Mult2 (cf. figure 2.3), Div2 ou Sqrt) is a structural
description composed of 2 or more components :

1. AddFP, MultFP (cf. figure 2.4), DivFP, SqrtFP : floating point computation
(combinatorial or pipelined).

2. Pipe(cf. figure 2.5) : shift register used in various cases.

3. (AddFP_1, MultFP_1,...) : another algorithm. If so, the first algorithm becomes
AddFP_0, MultFP_0.

Mult2

m_o

reset_i

clk_i

pipe_g

latency_g

D1_i

D2_i

valid_i

valid_o

m_g

stall_i

m_g

type_g

m_g

m_g

wValid_g

ready_o

wValid_g

wValid_g

Figure 2.3: Mult2 top level interface
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MultFP

D1_i

D2_i
m_g

m_g

pipe_g

reset_i

clk_i

a_i

b_i

pipe_g

clk_i

reset_i

y_o m_s

en_install_s

wEwE

type_gtype_g

wFwF

m_g

Figure 2.4: MultFP top level interface

Pipe
reset

clkclk_i

reset_i

input output

ennstall_s

w

n

m_s
m_g

m_o
m_g

m_g

1

Figure 2.5: Pipe top level interface

In figures 2.3, 2.4 and 2.5, wE and wF generic constants define the width of expo-
nent(wE) and mantissa(wF, F for Fraction).

2.2.2 Pipe

A component Pipe was created to generate a variable shift register with a variable
width bus. Its structure is shown in figure 2.6.

2.2.3 AddFP, MultFP, DivFP, SqrtFP

The operation in floating point was implemented as follow (cf. figure 2.7 :

• The input signals are separated in sign, exponent and mantissa.

• The operation is executed in combinatorial or pipelined version. The depth of
the pipeline depends on the operation.

• In parallel, a test of inputs is executed to check the exceptions values . The
exception is propagated to output to force the result.
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• Another block determines if an exception occurred during the computation and
force the result in output if necessary.

2.2.3.1 Input exceptions

Addition/Subtraction
Nb 0 +∞ −∞ NaN

Nb Nb Nb +∞ −∞ NaN

0 Nb 0 +∞ −∞ NaN

+∞ +∞ +∞ +∞ NaN NaN

−∞ −∞ −∞ NaN −∞ NaN

NaN NaN NaN NaN NaN NaN

Multiplication
Nb 0 +∞ −∞ NaN

Nb Nb 0 +∞ −∞ NaN

0 0 0 NaN NaN NaN

+∞ +∞ NaN +∞ −∞ NaN

−∞ −∞ NaN −∞ +∞ NaN

NaN Nb Nb NaN NaN NaN

Division
Nb 0 +∞ −∞ NaN

Nb Nb NaN 0 0 NaN

0 0 NaN 0 0 NaN

+∞ +∞ NaN NaN NaN NaN

−∞ −∞ NaN NaN NaN NaN

NaN Nb Nb NaN NaN NaN

Square root
A

√
A

Nb Nb

0 NaN

+∞ +∞

−∞ 0

NaN NaN
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2.2.3.2 Output exceptions

During an operation, the result may be outside the limits of the standard IEEE 754
single or double precision. In this case, the result must be limited to values 0 or ∞.
For the single precision, the computation of exponents is realized on 9 bits (1 bit for
carry). The treatment of exceptions is done as following :

8 7 6 5 4 3 2 1 0

exponent

1. exponent = "011111111"⇒ result = ∞

2. exponent= "000000000"⇒ result = 0

3. bit 8 and 7 = "10"⇒ result = ∞

4. bit 8 and 7 = "11"⇒ result = 0

Explications point 3 and 4 :

• The largest possible result is obtained by multiplying two numbers with the
exponent 011111110". During this operation, the exponent becomes :

011111110 + 011111110− 1111111 = 101111101
This example shows that when the result is too large and must apply the infinite, the
two most significant bits of the exponent are "10".

• When the division of a small number to a large one, the exponent result is :

000000011− 011000000 + 1111111 = 111000010
This example shows that when the result is too large and must apply the infinite, the
two most significant bits of the exponent are "11".

2.2.3.3 Operation

A detailed description of the various operators are found at the end of this chapter,
in the form of schematics:

• Addition: section 2.6.1, page 38

• Multiplication: section 2.6.2, page 42

• Division: section 2.6.3, page 47

• Square root: section 2.6.4, page 51

• Comparison: section 2.6.5, page 55

Math2mat User Manual c©HES-SO // ISYS



30 CHAPTER 2. BLOCKS

2.2.4 Compare block

For the if...else implementation, we need to compare two values and know which
number is bigger, smaller or if the two signals are equal. This block, completely com-
binatorial, performs this operation. It also includes the component pipe to propagate
the signal valid_i to indicate when the result is valid (depending on the latency).
Figure 2.8 shows the interface of this block.

2.3 VHDL code organization

2.3.1 Source files

Files name :

• A file with pkg_ is a package.

• A file with _tb is a testbench.

• A file without this two terms is a source code.

Description :
misc.vhd : this file contains the component pipe. If another useful

component must be created, insert it in this file.
delay.vhd : cell delay to delay an output and its validation signal.
add2.vhd : cell addition.
mult2.vhd : cell multiplication.
div2.vhd : cell division.
sqrt.vhd : cell square root.
pkg_definition.vhd : Constants and functions declaration.
pkg_cellule.vhd : components add2, mult2, div2, sqrt and delay declara-

tion.
Compilation script:
A script compile.do was realized to execute the compilation of source files in the
correct order. This file is in the folder /do.

2.3.2 Version of the operators

The version of the operator is determined using the generic constants of the com-
ponent. The generic constant type_g is used to determine the algorithm. Only the
addition is implemented with one algorithm and therefore doesn’t have this con-
stant. The generic constant pipe_g determines the combinatorial or pipelined ver-
sion. latency_g constant determines the latency time (number of clock period)
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before the output is stable for the combinatorial version. And finally the generic con-
stant m_g choose the single or double precision (be careful, not all algorithms are
implemented in double precision).
The algorithms SRT4 for the division and SRT2 for the square root were taken from
the library FPLibrary directed at ENS Lyon.
http://www.ens-lyon.fr/LIP/Arenaire/Ware/FPLibrary/

2.3.2.1 Add2

3 generic constants : m_g, pipe_g et latency_g

• m_g = 32 for single precision and m_g = 64 for double precision

• latency_g = 0 and pipe_g != 0 , pipelined version

• pipe_g = 0, combinatorial version, latency_g determines the time (number
of clock period) before the output is stable.

2.3.2.2 Mult2

4 generic constants : m_g, pipe_g, latency_g and type_g

• m_g = 32 for single precision and m_g = 64 for double precision (double only for
wired multiplier).

• type_g = 0 : multiplier carry save adder

– pipe_g != 0 and latency_g = 0, pipelined version.
– pipe_g = 0, combinatorial version, latency_g determines the time (num-

ber of clock period) before the output is stable.

• type_g = 1 : wired multiplier

– pipe_g != 0 and latency_g = 0, pipelined version.
– pipe_g = 0, combinatorial version, latency_g determines the time (num-

ber of clock period) before the output is stable.

2.3.2.3 Div2

4 generic constants : m_g, pipe_g, latency_g and type_g

• m_g = 32 for single precision and m_g = 64 for double precision (double only for
SRT4 algorithm).

• type_g = 0 : SRT4 algorithm

– pipe_g != 0 and latency_g = 0, pipelined version.
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32 CHAPTER 2. BLOCKS

– pipe_g = 0, combinatorial version, latency_g determines the time (num-
ber of clock period) before the output is stable.

• type_g = 1 : algorithm "Array of soustracteurs"

– pipe_g != 0, pipelined version.
– pipe_g = 0, combinatorial version

• type_g = 2 : algorithm "Successive approximations".

– pipe_g = 0, combinatorial version.

2.3.2.4 Sqrt

4 generic constants : m_g, pipe_g, latency_g and type_g

• m_g = 32 for single precision and m_g = 64 for double precision

• type_g = 0 : SRT2 algorithm

– pipe_g != 0 and latency_g = 0, pipelined version.
– pipe_g = 0, combinatorial version, latency_g determines the time (num-

ber of clock period) before the output is stable.

• type_g = 1 : non-restoring algorithm

– pipe_g != 0 and latency_g = 0, pipelined version.
– pipe_g = 0, combinatorial version, latency_g determines the time (num-

ber of clock period) before the output is stable.

2.4 Synthesis results

A synthesis process was conducted on all blocks.
Table 2.2 shows all the synthesis results made with the synthesizer XST (Xilinx) and
the FPGA VirtexII xc2v1000-6bg575.
Synthesis with Virtex xc2v8000-5ff1152 :

• 1x Add2(pipelined) : 393 Slices, 1%

• 5x Add2(pipelined) : 1971 Slices, 4%

• 1x Mult2(pipelined) : 979 Slices, 2%

• 5x Mult2(pipelined) : 4900 Slices, 10%

Table 2.3 shows all the synthesis results achieved with the synthesizer Precision and
the FPGA Virtex5 5VLX110FF676. (17280 Slices)
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Single precision Double precision

TYPE Slices % Fmax Pipes Slices % Fmax Pipes

Add2

Combinatorial 664 12% 1801 35%

Pipelined 408 7% 170 MHz 7 2714 53% 21 MHz 7

Mult2

Wired multiplier

Combinatorial 105 2% 345 6%

Pipelined 155 3% 112 MHz 5 442 8% 76 MHz 5

Carry save adder

Combinatorial 885 17%

Pipelined 956 18% 203 MHz 7

Div2

SRT4

Combinatorial 598 11% 2490 48%

Pipelined 1049 20% 139 MHz 16 4166 81% 100 MHz 30

Array of substractor

Combinatorial 2056 40% 6.8 MHz

Pipelined 1904 37% 139 MHz 30

Successive approximations

Pipelined 3195 62% 6.3 MHz

Sqrt

SRT2

Combinatorial 244 4% 901 17%

Pipelined 400 7% 132 MHz 16 1438 28% 96 MHz 32

Non-restoring

Combinatorial 426 8% 1698 33%

Pipelined 701 13% 163 MHz 28 2778 54% 122 MHz 57

Table 2.2: Synthesis results with the synthesizer XST (Xilinx) and the FPGA VirtexII
xc2v1000-6bg575
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Single precision Double precision

TYPE Slices % Fmax Pipes Slices % Fmax Pipes

Add2

Combinatorial 106 0.61% 80 MHz 1 278 1.61% 60 MHz 1

Pipelined 122 0.71% 267 MHz 7 276 1.6% 170 MHz 7

Mult2

Wired multiplier

Combinatorial 27 0.16% 97 MHz 1 98 0.57% 60 MHz 1

Pipelined 47 0.30% 206 MHz 5 102 0.59% 76 MHz 5

Carry save adder

Combinatorial 416 2.41% 87 MHz 1

Pipelined 318 1.84% 338 MHz 7

Div2

SRT4

Combinatorial 211 1.22% 23 MHz 1 863 5.00% 9 MHz 1

Pipelined 321 1.86% 242 MHz 16 1295 7.49% 201 MHz 30

Array of subtractors

Combinatorial 263 1.52% 7 MHz 1

Pipelined 547 3.17% 156 MHz 30

Successive approximations

Combinatorial 500 2.89% 7 MHz 1

Sqrt

SRT2

Combinatorial 112 0.65% 24 MHz 1 434 2.51% 9 MHz 1

Pipelined 147 0.85% 230 MHz 16 530 3.07% 163 MHz 32

Non-restoring

Combinatorial 183 1.06% 18 MHz 1 781 4.52% 6.7 MHz 1

Pipelined 261 1.51% 265 MHz 28 990 5.73% 216 MHz 57

Compare

Combinatorial 17 0.10% 333 MHz

Mult2 with a constant value (wired mulplier)

Pipelined 40 0.23% 206 MHz

Table 2.3: Synthesis results with the synthesizer Precision and the FPGA Virtex5
5VLX110FF676.
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2.5 Square root algorithm

2.5.1 Principle

Number representation in floating point is calculated as following:

F = M ∗ 2E

The square root of a number in floating point :
If E is even :

√
F =
√

M ∗ 2E/2

If E is odd :
√

F =
√

M/2 ∗ 2E/2+1

The square root of the mantissa was implemented with two different algorithms. The
first was taken from an existing library (SRT2 algorithm) and the other was realized
by ourselves (non-restoring algorithm).

2.5.2 Non-restoring square root

The square root of the mantissa is calculated through the following recurrence equa-
tion: 

X0 = 0, r0 = M

q0 = 1, qi+1 =

{
+1 if ri ≥ 0
−1 else

ri+1 = 2 ∗ ri − 2 ∗ Xi ∗ qi+1 − 2−(i+1)

Explication :

• ri is the ith partial remainder.

• Xi is the ith bit of square root result.

The computation is divided into four stages :

1. the value of the partial remainder is shifted a bit left to get 2 ∗ ri.

2. The value of qi+1 is inferred by the sign of the partial remainder. If it’s positive,
qi+1 = 1 and if it’s negative, qi+1 = −1.

3. the value of the square root is shifted a bit left to get 2 ∗ Xi.

4. The computation of the partial remainder ri+1 can be done using the results of
the first three stages.

Computation of X at the ith step, example :

X1 = 0.12

i f q2 = −1, X2 = X1 − 0.012 = 0.012

i f q2 = 1, X2 = X1 + 0.012 = 0.112
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2.5.2.1 Example

Square root of 0.5 on 6 bits : theoretical value=
√

0.5 = 0.707107

R0 = 0.5 0 0 . 1 0 0 0 0 0 X0 = 0
2 ∗ r0 0 1 . 0 0 0 0 0 0 q1 = 1 X1 = 0.1
−(2 ∗ X0 + 2−1) - 0 0 . 1 0 0 0 0 0

r1 0 0 . 1 0 0 0 0 0
2 ∗ r1 0 1 . 0 0 0 0 0 0 q2 = 1 X2 = 0.11
−(2 ∗ X1 + 2−2) - 0 1 . 0 1 0 0 0 0

r2 1 1 . 1 1 0 0 0 0
2 ∗ r2 1 1 . 1 0 0 0 0 0 q3 = −1 X3 = 0.101
+(2 ∗ X2 − 2−3) + 0 1 . 0 1 1 0 0 0

r3 0 0 . 1 1 1 0 0 0
2 ∗ r3 0 1 . 1 1 0 0 0 0 q4 = 1 X4 = 0.1011
−(2 ∗ X3 + 2−4) - 0 1 . 0 1 0 1 0 0

r4 0 0 . 0 1 1 1 0 0
2 ∗ r4 0 0 . 1 1 1 0 0 0 q5 = 1 X5 = 0.10111
−(2 ∗ X4 + 2−5) - 0 1 . 0 1 1 0 1 0

r4 1 1 . 0 1 1 1 1 0
2 ∗ r4 1 0 . 1 1 1 1 0 0 q6 = −1 X6 = 0.1011012

X6 = 0.703125
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2.6 Blocks schematics

2.6.1 Addition
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FA FA FA FA

1001

x1101

0001001

0000000

0100100

1001000

1110101

PP0

PP1

PP2

PP3

PP00PP10PP20

A

PP01PP11PP21PP02PP12PP22PP03PP13PP23

=> PP0 + PP1 + PP2 = S0 + S1

...

S10

0

S00S11S01S12S02S13S03S14

A

A

B

PP0 PP1 PP2    PP3

S0 S1

SOMME

Multiplication 

(carry save adder)

FA

ac b

sc

s = a xor b xor c

c = (a and b) or (a and c) or (b and c)
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1 1 1 1 1 1 1 1

2 2 2 2 2

3 3 3

4 4

5 6

7

8

SOMME

PP0 PP1 PP2 PP3 PP4 PP5 PP6 PP7 PP8 PP9 PP10 PP11 PP12 PP13 PP14 PP15 PP16 PP17 PP18 PP19 PP20 PP21 PP22 PP23

s0_s

s1_s

49

48

48

s2_s

s3_s

s4_s

s5_s

(0) (1) (2) (3) (4) (5) (6) (7) (8) (9)

(0) (1) (2) (3) (4) (5) (6) (7) (8) (9) (10) (11) (12) (13) (14) (15)

(0) (1) (2) (3) (4) (5)

s6_s

s7_s

(0) (1) (2) (3)

s8_s

s10_s

(0) (1)

s9_s

s11_s

(0) (1)

s12_s

s13_s
(0)

(1)

s14_s (0) (1)

y_s

Multiplication 24 x 24 bits
D Q

D Q

D Q

Math2mat User Manual c©HES-SO // ISYS



2.6. BLOCKS SCHEMATICS 47
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2.6.4 Square root
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2.6.5 Comparison
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Figure 2.6: Pipe structure
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Figure 2.7: Structure of an operation
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Compare

smaller_o

reset_i

clk_i

latency_g

d1_i

valid_i

valid_o
wValid_g

stall_i

m_g

wValid_g

wValid_g

 m_g

d2_i
 m_g

bigger_o

equal_o

ready_o

Figure 2.8: Compare block interface
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Chapter 3
Generation

3.1 Introduction

The main purpose of this report is to describe the mechanisms put in place to generate
VHDL files corresponding to an octave function. To understand the details of the
generation of an octave function, an initial study from the outside of the functioning
of a Math2Mat block and its signals is necessary. It will then be possible to enter into
the details of generations of the different elements encountered in the structure such
as polynomials, conditional statements and loops. Wrappers allowing to connect the
various hardware blocks representing the operations will also be discussed.

3.1.1 Block representation

The figure 3.1 shows a generic Math2mat block comprising n number of entries and
m number of outputs.

Ready_o

Valid_i

Data_i

Ready_o

Valid_i

Data_i

Ready_o

Valid_i

Data_i

Ready_i

Valid_o

Data_o

Ready_i

Valid_o

Data_o

Ready_i

Valid_o

Data_o

Math2Mat Bloc

Input 1

Input 2

Input n Output m

Output 2

Output 1

Figure 3.1: Generic Math2Mat block

Each input and output is accompanied by three signals. Input signals have the fol-
lowing meanings:
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• Data_i: this signal is controlled by the user of the block. It indicates the actual
value of the data. Its size is 32 or 64 bits depending on the chosen architecture.

• Valid_i: this signal is controlled by the user of the block. It indicates the validity
of the data. It is represented by a single bit.

• Ready_o: this signal is returned by the Math2Mat block. It indicates when the
input is ready to receive data. It is represented by a single bit. Output signals
have the following meanings:

• Data_o: this signal is returned by the block. It indicates the actual value of the
data. Its size is 32 or 64 bits depending on the chosen architecture.

• Valid_o: this signal is returned by the block. It indicates whether the data is
currently valid. It is represented by a single bit.

• Ready_i: this signal is controlled by the user of the block. It indicates when the
output is ready to receive data. It is represented by a single bit.

3.1.2 Generic wrapper

To avoid conflict between the names of inputs/outputs of a Math2Mat block and
names of inputs/outputs of different VHDL modules around the Math2Mat block,
generic wrappers are generated. They used to math2math own names for each of the
inputs and outputs. Inputs and outputs of wrappers are using specific names for each
Math2Mat inputs and outputs. Figure 3.2 illustrates an example of the generation of
a Math2Mat block and using two inputs a and b and one output c.

Ready_o

Valid_i

Data_i

Ready_o

Valid_i

Data_i

Ready_i

Valid_o

Data_o

Math2Mat Bloc

b_i

b_Ready_o

b_Valid_i

a_i

a_Ready_o

a_Valid_i

s_o

s_Ready_i

s_Valid_o

Input_i

Input_Ready_o

Input_Valid_i
Result_o

Result_Ready_i

Result_Valid_o

Generic wrapper

a

b

s

Figure 3.2: Generic wrapper

Four tables of std_logic can represent all input and output ready and valid:

• Input_valid_i and Input_ready_o represent the ready and valid in-
puts.

• coucou

Two other tables of std_logic_vector Result_o and Input_i allow represent-
ing all inputs and outputs. The various indexes of all these tables must match. Tables
3.3 and 3.4 shows the positioning signals in these six tables.
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Input_i Input_Valid_i Input_Ready_o

Input_i[0] a_i Input_Valid_i[0] a_Valid_i Input_Ready_o[0] a_Ready_o

Input_i[1] b_i Input_Valid_i[1] b_Valid_i Input_Ready_o[1] b_Ready_o

Figure 3.3: Input tables representation

Result_o Result_Valid_o Result_Ready_i

Result_o[0] s_o Result_Valid_o[0] s_Valid_o Result_Ready_i[0] s_Ready_i

Figure 3.4: Output tables representation

3.1.3 Utilization

A Math2Mat block is seen from the outside regardless of content. The user relies
on signals ready and valid to control it as he wishes. He will certainly prefer to
transmit all inputs at the same time. However, some data may not be ready to receive
data. We’ll see later that the user has the possibility to force the block to indicate that
an input is ready only if all inputs are.

3.1.3.1 Timing diagrams

To better understand how a block from the outside, consider the timing diagram of
figure 3.5 with two inputs and one output.
In this figure, we observe the sending of five data on each input and the reception
of six data on the output of the block. The processing of a given takes seven clock
cycles. The block operates in its usual case. Indeed, each input is always ready to
receive data, the data is sent at the same time and the external user of the block is
ready to receive data also. The timing diagram of figure 3.6 helps to highlight the
behavior of the same block in one less common case.
One notice directly the influence of the control signals valid and ready on the flow
of data within the block. This diagram is not absolute because the value of the ready
input depends directly to the content of the block. Indeed, as we shall see later a
number of fifos may be present within the block and cause delays on the data.

3.1.4 Content block

3.1.4.1 Usual content

The content of a block is composed of interconnections of different sub-blocks repre-
sented by operators. Each operator is used to construct a polynomial, a conditional
statement or a loop. To interconnect all of these operators, wrappers including con-
trol logic are inserted. When an input is used by several operators, a combinational
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Reset_i

Clk_i

A_i

A_Valid_i

A_Ready_o

B_i

B_Valid_i

B_Ready_o

C_o

C_Valid_o

C_Ready_o

Output 

Inputs

Figure 3.5: Timing diagram of a usual case

logic is also required. The diagram of figure 3.7 shows the typical contents of a block.
The next sections of this report will present the entire framing element operators. This
pattern will be partially changed on the chapter on loops where some new elements
will appear.

3.1.4.2 Propagation of ready

When the user of a Math2Mat block is not ready to receive data, the ready signal is
spread within the entire block wrapper. Figure 3.8 shows this propagation.
The number n of clock pulses to propagate the ready on inputs depends on the con-
tents of the wrapper that we will see later. The bold arrows represent the propagation
of the signal on the inputs.

3.2 Wrapper

3.2.1 Introduction

A wrapper is used to interface input and output signals data, valid and ready
with a particular operator. Each operator can have one, two or three inputs and one
output. It also provides the following entries:

• Valid_in: this signal indicates whether the operator entries are valid.

• Valid_out: this signal indicates if the output of the operator is valid.

• Ready_out: this signal indicates whether the operator is ready to receive data.
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Reset_i

Clk_i

A_i

A_Valid_i

A_Ready_o

B_i

B_Valid_i

B_Ready_o

C_o

C_Valid_o

C_Ready_o

Output 

Inputs

Figure 3.6: Timing diagram of a non-usual case

• nStall: his active low signal is used to stop the chain of calculation of the oper-
ator.

All these signals are represented by a single bit. The outer part of the block diagram
3.9 illustrates the interface to develop for a wrapper who includes an operator with
two inputs and one output.
The number of generated wrappers must match the number of different operators
used in the octave function. Automatic generation of wrapper must be flexible on
the number of inputs and outputs of the operator.

3.2.2 Implementation

A wrapper is composed of three separate parts:

• The first part allows the synchronization of ready and signals valid inputs of
the wrapper.

• The second part includes the implementation of the combinational logic for the
management of valid and ready signals to the operator and the wrapper.

• The third part maintains a valid output when disabling the block by the signal
ready_in.

Figure 3.10 represents a wrapper for an operator having two inputs and one output.
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Operator

Wrapper

Operator

Wrapper

Operator

Wrapper

Combinational 

logic

=
Ready_o

Valid_i

Data_i

Figure 3.7: Block content

Operator

Wrapper

Operator

Wrapper

Operator

Wrapper

s_Ready_i <= ‘0’

d_Ready_o <= ‘0’

c_Ready_o <= ‘0’

b_Ready_o <= ‘0’

a_Ready_o <= ‘0’

2 to n clock pulses

2 to n clock pulses

2 to n clock pulses

Figure 3.8: Propagation of ready Timing diagram of a usual case

3.2.2.1 Internal fifo

The internal fifos will eliminate some combinational loops between different wrap-
pers. These loops can occur when two wrappers are bound together by their in-
puts and outputs. This phenomenon will be discussed in the section on polynomials.
These fifos can overcome the combinatorial link between valid and ready input for
a wrapper. Their size is set by default to two to remove the combinatorial link and
allow data sends in bursts. Indeed, if their size was one, the HDL description fifos
could not send bursts. The fifo would be full, then empty, then full, etc. Thereafter,
we’ll see that these fifos will also serve as a buffer for a multi-used signal.

3.2.2.2 Combinational logic

The combinational logic between the fifos and operator is used to:

• Manage the influence of the inputs of the operator with each other.
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Operator

A

B

nStall
Valid in

Valid out

result

Ready out

A_Ready_o

A_Valid_i

A_i

B_Ready_o

B_Valid_i

B_i

Result_Ready_i

Result_Valid_o

Result_o

Figure 3.9: Block diagram of a wrapper

• Indicate the validity of inputs present on the operator content in the wrapper.

• Spread the state of the ready signal of the wrapper on the wrapper operator
inputs.

• Propagate the state of the ready signal of the operator contained in the wrapper
to the inputs of the operator.

3.2.2.3 Synchronisation

This block allows the management of three different signals:

• The output of the operator is connected to a multiplexer and a register also con-
nected to this multiplexer. This register keeps the output state of the operator
when the input ready of the wrapper is inactive. This ready is then used
to select the direct output of the operator if it is active or memorize output of
the register if it is not. Thus, the output of the operator is not lost and can be
obtained during the reactivation ready.

• The mechanism used for the output of the operator is also done for valid sig-
nal of the operator.

• The ready input is connected to a registry to limit the combinatorial path of
this signal if the block Math2Mat includes a large number of operators. This
synchronization makes it possible to save the output data of the operator de-
pending on the state of the ready as we seen previously.

3.3 Mathematical function

3.3.1 Introduction

The first generation produced is that of polynomials. It mainly covers the elements
previously seen by adding a combinational logic multi-used signals manager. To
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FIFO
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data

read

write empty

full

result

ready_out1
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Figure 3.10: Wrapper for a basic operator

move from an octave code to a VHDL description, a number of transformations are
needed on the structure. Indeed, the structure contains a high level description of
the function and includes not all control signals seen previously. This section also
presents mechanisms to obtain the latency of a function and adding compensation
fifos for some operators to ensure this latency.

3.3.2 Multi-used signal

3.3.2.1 Structure modifications

To show the necessary changes in the structure, consider the following octave code
and its corresponding structure shown in figure 3.11.

tmp = a+b;
S = tmp+a+tmp;

Example

Figure 3.11: Structure state before generation
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We note that signals a and tmp are used twice. Materially, it is impossible to represent
these signals as one signal. That’s why these signals should be decomposed into two
in order to avoid possible conflicts. We obtain the structure shown in figure 3.12.

Figure 3.12: Structure state after generation

Note that both signals have indeed been separated into two. It is necessary to define a
logic which interacts with both signals. That transformation of the structure must be
present for all signals contained in octave functions. These transformations naturally
generalize when the signals are used more than twice.

3.3.2.2 Combinatorial logic

The combinatorial logic must respect the following requirements:

• The output ready signal must combine all ready signals.

• The input valid signal must be shared by all inputs.

• If one input is not ready to receive data, the other inputs related to this input
should not be ready either.

The first two points are relatively easy to achieve. Indeed, just ready to consolidate
and decompose the signal valid. Figure 3.13 shows an example for a signal a_m2m_0
used twice.

Operator

Wrapper
Operator

Wrapper

a_m2m_0

a_m2m_Ready_0

a_m2m_Valid_0

a_m2m_0_0

a_m2m_0_1

a_m2m_Valid_0_0

a_m2m_Valid_0_1

a_m2m_Ready_0_0

a_m2m_Ready_0_1

b_m2m_0

b_m2m_Ready_0

b_m2m_Valid_0

s_m2m_0

s_m2m_Ready_0

s_m2m_Valid_0

Figure 3.13: Combinational logic of multi-used signal

The data signal is directly shared by the two decomposed signal. The ready signal
is simply a and between the two ready decomposed signals. The valid signals are
obtained in a slightly more complex manner. Indeed, in order to prevent the sending
of new data on common inputs to decomposed inputs where the value is valid, it
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is necessary to interact with the valid inputs. The scenario shown in figure 3.14 is
used to represent this case.

+

+

a_m2m_0

b_m2m_0

c_m2m_0

d_m2m_0

e_m2m_0

1
2

3

4

d_m2m_0_ready

b_m2m_0_0_ready

a_m2m_0_ready

b_m2m_0_1_valid

c_m2m_0_ready

<= ‘0’

<= ‘0’

<= ‘0’

<= ‘0’

<= ‘0’4)

3)

2)

1)

Figure 3.14: Principle of multi-used variables logic

The main point of this operation is to disable the signal through the wrapper c_m2m_0_ready
signal b_m2m_0_1_valid. Again, this mechanism can be generalized to a large
number of inputs and dependencies.

3.3.2.3 Fifos compensation

To ensure a maximum rate, some compensation fifos are needed. Figure 3.15 shows
a case requiring such compensation.

c_m2m_0

d_m2m_0

a_m2m_0

b_m2m_0

Op2

s_m2m_0

Op1

Op4

0

0

0

0

10

10

20

0

Op3

Figure 3.15: Example of case requiring fifos compensation

Assuming that all these additions have the same latency of 10, we can fix as above
the latency of each entry. If one observes the two inputs of operator Op3 and Op4, we
notice that their latencies differ by a value of 10. These are two different cases:

• The case relative to Op3 is the classic case where a multi-used signal is used
by operators whose inputs have different latencies. It must then compensate
for these latencies relative to the signal connected to the input of the lowest
latency. In the case above the input who has the lowest latency is a_m2m_0.
Input b_m2m_0 connected to Op3 must matched 10.

• The case relative to Op4 is not related to multi-used inputs. It is present only
when both inputs of an operator have different latencies. It must then check
whether the entries sharing common signal and offset the difference in this case.
On the figure above the inputs of Op4 share the input b_m2m_0.

Figure 3.16 shows the same case with compensation fifos of depth 10.
Regarding the calculation of latency inputs within the structure, it takes into account
the following values:
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c_m2m_0

d_m2m_0

a_m2m_0

b_m2m_0

Op2

s_m2m_0

Op1
0

0

0

0

10

20
Fifo

Fifo

Op4

Op3

Figure 3.16: Example of case with fifos compensation

• Latency signal whose input comes.

• Latency of the operator.

• Internal fifos located in the wrappers.

This principle can also be generalized to a higher number of multi-used variables.
Note that if you want to send data at the same time, compensation fifos must be
added as soon as the latencies of the two inputs are different. This choice can be
made before the generation with a particular option of the tool. We will see later that
for a loop, the inputs must always be served simultaneously. Then all these fifos are
essential. Adding fifos is changing the size of internal fifos already present inside
wrappers.

3.3.3 Latency time

The latency time of a polynomial can be directly linked to the previous point. In fact,
it corresponds to the latency of the maximum output. Assuming that data is sent to
each clock pulse, the time needed to calculate n data will be as follows:
Consider the scenario shown in figure 3.17.

Number of data to send: 5000

+

+
0

0

0

0

10

18
Fifo1

Fifo2

*

-

Latency time for «*» operator: 8

Latency time for «+» operator: 9

Latency time for «-» operator: 7

0 + 9 + 1

18 + 8 + 1 = 27

10 + 7 + 1

0 + 9 + 1

Fifo1 size:  10

Fifo2 size:   8

Latency time = 5000 + 27 - 1 = 5026

Figure 3.17: Example of latency time calculation

The value of 1 is added to compensate the clock pulse required to write/read access
in internal fifos inside wrappers. For the final calculation, the value of 1 is subtracted
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given that the clock pulse nř0 is the first. This result corresponds to the minimum
latency that can be obtained.

3.3.4 Internal fifo justification

The internal fifos is fully justified when the inputs and outputs of two wrappers are
linked. Figure 3.18 illustrates a case from the dynamic view presenting this phe-
nomenon.

Figure 3.18: Problematic case without internal fifos

The right circle represents the dependence between the outputs of both wrappers
multiplications. The left circle represents the strong dependence between the two
inputs of the two wrappers. When a particular output is not ready to receive data,
the absence of internal fifos create a combinational loop.

3.4 Conditional statement

3.4.1 Introduction

Conditional statements if echo many of the concepts covered during the generation
of polynomials. Indeed, the bodies of if and all that surrounds them are constitutive
of polynomial. Only the status of if has not been discussed previously. This section
presents the details of managing the condition.

3.4.2 Condition signal

3.4.2.1 Principle

Consider the following octave code example to express a simple instruction condi-
tional if:
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if (a < c) then
s = a-b;
else
s = c-d;
endif

Example

Figure 3.19 shows the graphical representation of the code above. Surrounded oper-
ators show additions to a simple polynomial.

a_m2m_0

b_m2m_0

c_m2m_0

d_m2m_0

s_m2m_0

-

-

>

Mux

0

1

s

Figure 3.19: Graphical representation of a conditional instruction if

The first surrounded operator is a single operator >. Every operator is surrounded by
a wrapper and has its own latency. This operation is identical to any block presented
in the previous section. Note that the output of this operator has the particularity of
being a single bit. The second surrounded operator is a multiplexer operator. It was
the only operator consisting of three inputs. It is surrounded by a wrapper general-
ized to three inputs.

3.4.2.2 Latency

In the previous example and after setting all the latencies we obtain the result shown
in figure 3.20.
It is noted that only one fifo is necessary. It is determined simply by generalizing the
principles previously seen but for a three inputs operator. In this example, we note
that the input condition depends on a_m2m_0 and c_m2m_0. The input 1 of multi-
plexer also depends on a_m2m_0 and therefore implies a fifo. If no dependency was
present between the different inputs, this fifo can be automatically set for allowing
the sending of all input data at the same time.
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a_m2m_0

b_m2m_0

c_m2m_0

d_m2m_0

s_m2m_0

-

-
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Mux

0

1

s

Latency time for «>» operator: 5

Latency time for «-» operator: 7

0 + 7 + 1

0 + 7 + 1

0 + 5 + 1
0

0

0

0

0

0

Fifo1

Fifo1 size:  2

Latency time for «mux» operator: 0

8 + 0 + 1

Figure 3.20: Latency time of a conditional instruction if

3.5 For Loop

3.5.1 Introduction

The for loop are the most complex part of the generation. Indeed, its complexity
is due to differences in the loop octave and its representation in the structure and
the loop material to build. The purpose of this section is to show how the missing
information in the structure was filled. A certain number of units developed for this
purpose will therefore be presented.

3.5.2 Principle

To simplify the description of generation, we will break it down into several steps.
At each stage a higher level of specification will be presented.

3.5.2.1 Desired rate

The idea is to circulate a data per clock cycle inside the loop and store each output
data in a memory to the resort in order. In fact, the condition is unique to each data
implying that came up after another in the loop can exit before. It is therefore nec-
essary to buffer these data in a memory to guarantee an order consistent among the
output data. A data can enter the loop only if a memory index is available. The
diagram of figure 3.21 illustrates this principle.
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Inputs

Loop for

1

Data 22

3

4

Memory

Body (latency = 4)

+

*

-

Data 4Data 3Data 2Data 1

Outputs

Figure 3.21: Example of desired rate

The diagram above represents a loop with a latency of 4. Four data may buckle in
both in the loop. Data is located on each floor of the body of the loop. The end con-
dition of the second data has already occurred and the data was written in memory.
It will exit the loop when the condition of the first data will be realized. Meanwhile
the data continues to turn in the loop but its result is no more use.

3.5.2.2 First decomposition

A for loop consists of three distinct parts as presented in figure 3.22.

Init Body
Recorder 

Buffer
Outputs

Read/Write Inputs

Read Inputs

Figure 3.22: First decomposition of a for loop

• The first part allows the initialization and management of the loop inputs. There
are two types of inputs. The inputs used only in reading in the loop and those
used in reading and writing. The inputs used also in writing can be correspond-
ing to an output of the loop.

• The second part represents the content of the loop and its end condition test.
Unlike polynomial or conditional instruction if, a number of additional syn-
chronizations are required.
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• The third and final part manages the results of the loop. We will see later that
these are managed by a recording mechanism. The parts are intimately linked.
The remainder of this section presents their content and their interactions.

3.5.2.3 Second decomposition

Let’s look specifically at blocks init and memory using figure 3.23.

Body

Counter_Wr

Init input

Init input

Init input

Counter_Rd

Memory Read_Result

Outputs

Read Inputs

Init input Memory Read_Result

Read/Write Inputs

Figure 3.23: Second decomposition of a for loop

The block Init includes two different blocks:

• The Init_Input block allows to select the signals associated with its specific
input or else those who are through the for loop. The loop condition associated
with the loop data is used to perform this selection.

• The Counter_Wr block allows associating a number to each data in the loop.
This number is the index for writing the data into the memory. When new data
is ready to enter into the loop, a new number is assigned only if the maximum
number of data in the loop and the memory is not reached. The block Memory
includes three different blocs:

• The Memory blocks memory stores the output data of the loop. Given that the
data does not emerge automatically in the same order in which they came, this
memory allows reordering the data.

• The "Read_Result" block manages the loop communication with the output sig-
nals. It allows reading a data in the memory and keeping the data on the output
of the memory when an output is not ready to receive data.

• The Counter_Rd block provides the index of the next data to be read according
to the size of the memory.

3.5.2.4 Third decomposition

This last decomposition highlights the paths of loop data, result data and read/write
indexes. Depending on the type of data, different paths are used. There are two
different paths for loop data:
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• The first one is used by read input data. Since these data are not changed by
the body of the loop, it is necessary to buckle them before the body. These data
should also be delayed with fifos to compensate the latency of the body.

• The second one is used by read/write data. Since these data are modified by
the loop body, it is necessary to buckle them after the body. Provided that all the
outputs of the loop body have the same latency, it is not necessary to insert fifos.
If their latencies are different they may be delayed into the body by internal
fifos.

The path used by the output data may seem surprising. In fact, when the output
occurs before the loop body, the condition is not yet calculated. Thus, we must delay
the data and write into the memory only after the calculation of the condition. An
additional complete iteration of the loop is therefore necessary to obtain the output
data. Each write index is associated with a read/write data and must buckle at the
same time as its data. These indexes should also be delayed with fifos to compensate
the latency of the body. A read index is only used when reading in memory. It is
unique between two readings. He did not need to buckle. Figure 3.24 shows the
paths described above.

Body

Counter_Rd

Memory Read_Result

Memory Read_Result

Counter_Wr

Init input

Init input

Init input

Init input

Fifo

Fifo

Fifo

Fifo

Fifo

Outputs

Read Inputs

Read/Write Inputs

Figure 3.24: Third decomposition of a for loop

3.5.3 Body description

3.5.3.1 Connections

A number of connections are needed on the input signals from the body of the loop.
The loop works correctly only if the input data is perfectly synchronized. With the
help of an example with three inputs a, b and c, we will present the various inter-
connections made. To do this, let us analyze the scheme shown in figure 3.25.
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Figure 3.25: Connections between inputs, Init_Input blocks and loop inputs
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All input ready and valid interconnections for a loop are presented above. Two
outputs are used for each entry. The first is used by the content of the loop. The
second is used as the loop variable. For a read/write input, the result of the loop
body is used as a loop variable. Its current value is timed and recorded in memory if
the end condition is reached. These mechanisms can be generalized to any number
of inputs. All these connections can enter new data and turn data into the loop on
all inputs simultaneously. Without these connections, one could accept an input data
besfore the other involving a total desynchronization of the loop.

3.5.3.2 Iteration latency

Still not out of sync the data in the loop, all inputs of the operators contained in the
loop body must have the same latency. Thus each latency difference between two
inputs is compensated even if no dependencies between the inputs are present. In
fact, all the inputs are dependent on each other in a loop. Figure 3.26 shows a case of
compensation for different latencies within a loop.

+

+
0

0

0

0

10

18

Fifo2

*

Latency time for «*» operator: 8

Latency time for «+» operator: 9

Latency time for «-» operator: 7

0 + 9 + 1

18 + 8 + 1 = 27

10 + 7 + 1

0 + 9 + 1

Fifo1 size:  10

Fifo2 size:   8

0
Fifo1

-

10
Ouputs of «Init_Input» blocks

Figure 3.26: Iteration latency of a loop

We obtain easily the maximum latency of the loop. This latency represents the max-
imum number of data in the loop. It therefore set the minimum size of memories,
fifos and the number of read /write index.

3.5.3.3 Iterator and loop condition

The iterator and the loop condition are handled slightly differently:

• The iterator will always consist of an addition between the current value of the
iterator and the increment parameter value. The current value of the iterator is
its initial parameter value for the first iteration and its value for next iteration
loop. Once the value for the next iteration calculated, it is necessary to delay the
result by using a fifo. The iterator buckle with the data which it is associated.
An Init_Input block is inserted to the iterator as if was a standard input.

• The condition is calculated from the current value of the iterator and the end
parameter condition. It is also necessary to delay the result of the comparison
by using a fifo. The result is different at each iteration and does not need to
buckle with a specific data.

Diagram 3.27 shows the management of the loop condition and the iterator.
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Init input

FifoInitial parameter value 

Increment parameter value

End parameter value

+

FifoCmp Condition result

Figure 3.27: Principle of the loop condition the iterator

3.5.4 Blocks description

3.5.4.1 Init_Input

This block takes as data two different data:

• An input from outside the loop representing the initial data. It is used once only
during the first iteration.

• A data from inside the loop representing the loop data. It is recovered at the
output of the loop body if it is an entry for reading and writing and entered the
body if it is an input only used for reading.

The input Cond_i selects one of the two inputs. If the condition is equal to ’1’ then
enter Loop is selected. Otherwise,the entry Init is selected. A similar logic is per-
formed to the management of ready and valid. Figure 3.28 shows the inputs /
outputs of a block Init_Input.

Ready_o
Valid_i
Data_i

Init_Input Data_o

Clock_i

Reset_i

Data_Init_i

Data_Loop_i

Cond_i

Figure 3.28: Init_Input block

3.5.4.2 Counter_Wr

As we have seen previously, the minimum size of the output memory can be sized
using the latency of the loop body. From this value we can know the number of
indexes needed to write in the loop. The challenge of this pack is to provide the next
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write index of the memory to new data. There may however be no index available.
Indeed, if a maximum number of data is already in the loop or if a number of data
have already been written but not read yet, no index should be reallocated.
Two vectors are used to indicate the index of reading and writing in the memory.
The write index is updated at each writing event. The read index is received from the
Counter_Rd block. Each write index is associated with a valid signal. Writing will
actually occur when the validity signal of the write index is set to ’1’. From these data
and those provided by the loop body, this block can provide a valid write index and
a signal ready indicating to the Init_Input block when it can send a new data.
The write index and its validity signal buckle at the same time that the data on which
they are associated. Input signals representing the write index and its validity signal
indicate directly if the index is available or not. Figure 3.29 shows the Counter_Rd
block.

Counter_Wr

Ready_o Signal used by Init_Input blocks

Data_o

Data_Valid_o
Output write index and its validity signal

}

Clock_i

Reset_i

Adr_Rd_i

Ready_i

Cond_i

Read_i

Fifo_Ready_i

Signals from loop body used for

update write and read index


Data_i

Data_Valid_i
Input write index and its validity signal

{

Figure 3.29: Counter_Wr block

3.5.4.3 Counter_Rd

This counter is much simpler than Counter_Wr block. The ready signal comes from
the outputs of the loop. It is active if all outputs are ready to be served. The enable
signal indicates whether the data present at output of the memory are valid. Based on
these two signals, the read index is incremented or maintained. Figure 3.30 describes
the input/output block.

3.5.4.4 Memory

The minimum size of memory is set according to the maximum latency of the loop
body. A memory is associated with each output data. The write address signal and
its validity from the Counter_Wr bloc. A writing occurs when the write address
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Counter_Rd Count_o

Clock_i

Reset_i

En_i

Ready_i

Figure 3.30: Counter_Rd block

is valid and the signal Wr_i is active. A reading is possible when all the outputs
of the loop are ready to receive data. The output data from memory at a writing is
accompanied by a valid signal. Figure 3.31 describes the memory block.

Memory Data_o

Data_Valid_o

Clock_i

Reset_i

En_i

Ready_i

Adr_Valid_i

Adr_Rd_i

Adr_Rd_i

Data_i

Figure 3.31: Memory block
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Chapter 4
Verification

4.1 General Structure of the Testbench

Figure 4.1 shows the structure of the generated testbench.
The testbench is able to adjust easily to all types of designs with the few parameters
shown in table 4.1. These parameters are configured in the common.sv file.
An Octave function can have different implementations in VHDL. For example, if
a function takes a vector of 3 scalars as input, this can be translated into 3 different
parallel inputs in the DUT, or into a unique input which takes the data values in
serial. The common.sv file puts all these necessary parameters together to realise the
configuration.
Figure 4.2 shows a graphical UML-like representation of the testbench software struc-
ture. All classes whose name begins with M2M_ and the class Reporting have been
implemented for this project. All other classes belong to libraries which have been
included into the project to make some tasks easier to implement.

4.2 Inputs/outputs of the DUT

Input and output names are directly inspired by the names given in the Octave func-
tion. Data input port names match exactly to the input names of the Octave function.
Each data input is associated with 2 complementary signals, one that indicates that
the input data is valid and takes the name of the input port with the suffix "_Valid",
and another one that indicates that the DUT is ready to accept a new data on the
input port, and takes the name of the input port with the suffix "_Ready".
Result output port names match exactly to the output names of the Octave function.
Each result output is associated with 2 complementary signals, one that indicates
that the result on the output is valid and takes the name of the output port with the
suffix "_Valid", and another one that indicates to the DUT that the system is ready to
receive a new result and takes the name of the output port with the suffix "_Ready".
Monitored internal signals are handled as result output ports.
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Figure 4.1: Structure of the testbench

4.3 Data File Structure

All files with data values have the same internal structure. There is one file input,
internal or output variable of the Octave function. Each file begins with the number
of samples. This is followed by the length of the port vector, which is 1 if it is a scalar
or more than 1 if it is a vector. After that the sample values are listed.
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Figure 4.2: Testbench class diagram
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4.4 Channels Configuration

The testbench has an array of channels (see also Figure 4.1) and there are as many
channels as inputs, internals and outputs in the DUT. The size of this array will be
configured to make the testbench adaptable to different DUTs, using the constants
NUMBER_OF_DUT_INPUTS, NUMBER_OF_DUT_INTERNALS and NUMBER_OF_DUT_OUTPUTS.

4.5 Stimuli Generator

The stimuli generator reads the input data files. With the knowledge of NUMBER_OF_INPUTS,
NUMBER_OF_DUT_INPUTS and INPUT_PARALLEL it derives the number of data sam-
ples to be read, the number of channels and which inputs are parallel or serial. For
each input of the Octave function, the stimuli generator checks if this input is parallel
or serial in the DUT: if the input is parallel, it will decompose the data in the file to
send the 1st data on the 1st channel, the 2nd data on the 2nd channel, and so on until
each channel has received data. The stimuli generator does the same job again begin-
ning at the 1st channel. If the input is serial, the stimuli generator sends data one after
another to a single channel. The data rate is controlled by the control signals coming
from the DUT. The DUT indicates to the testbench if it is ready or not to accept new
data. The testbench will act in consequence and send new data only when the DUT
is ready to receive one. In a further step the stimuli generator will have to take care
about the way to send data. This is not implemented yet.

4.6 Driver

4.7 Monitors

The three monitors for input signals, internal signals and output signals detect valid
data passed on their interfaces and pass them as transaction to the corresponding
channel. There is one channel per NUMBER_OF_DUT_INPUT, NUMBER_OF_DUT_INTERNALS
or NUMBER_OF_DUT_OUTPUT.

4.8 Data Checker

The data checker works the same way as the stimuli generator does. It is based on the
constants NUMBER_OF_OUTPUTS, NUMBER_OF_DUT_OUTPUTS, and OUTPUT_PARALLEL
to determine which data read from the Octave file corresponds to the channel re-
ceived from the corresponding monitor. The data checker has a data verification task
(service_M2M_Launch_Check). It runs this task as many times as there are out-
put channels, i.e. as many as there are DUT outputs. Each task will examine one
and only one channel. The function predict_DUT_output has the responsibility
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to parse output data files. It reads a file, extract data and spreads theses data in one
or more queues depending if the result is expected serial or parallel. When the task
receives a transaction from the output monitor, it compares this transaction with the
data contained in the queue that corresponds to the channel. Monitored internal sig-
nals are handled the same way.

4.9 Timing Monitor

The timing monitor receives data samples from all other monitors. As the channel
transactions are executed in zero simulation time, these data samples can be used for
timing monitoring. The statistics shown in Table 4.2 are monitored. As this moni-
tor works in concurrence with the data checker, the function peek is used to get the
transactions from the channel without destroying them.

4.10 Testbench coverage

The testbench stops when all raised objections have been dropped. Tasks that raise
objections are the following:

• M2M_Input_Driver:body() ⇒ the testbench cannot stop while all data in
input files have not been sent to the DUT (through the tasks get_stim() and
drive() ).

• M2M_Input_Stim:body()⇒ opens the stimuli files and launches the put_stim()
task as many times as there is inputs in the Octave function.

• M2M_Input_Stim:put_stim()⇒ the testbench cannot stop while all stimuli
have not been read in the files and placed into channels.

• M2M_checker:service_M2M_Check_Output ⇒ the testbench cannot stop
while it receives data from the output monitor.

• M2M_internals_checker:service_M2M_Check_Internals ⇒ the test-
bench cannot stop while it receives data from the output monitor.

• M2M_timing_checker:service_M2M_Latency⇒ the testbench cannot stop
while it is measuring the latency

• M2M_timing_checker:service_M2M_CalculationTime⇒ the testbench
cannot stop while it is measuring the total calculation time

• M2M_timing_checker:service_M2M_InputRate⇒ the testbench cannot
stop while it is measuring the input rate

In this configuration, the testbench uses all the samples that are in input files, but
does not do any verification on output files (i.e. there is no error if the testbench
stops before all values in output files have been treated).
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4.11 Reporting

Reporting is unified in the Reporting class (see 4.2). It provides reporting functions to
the testbench to report information messages (reporting_info) or error messages (re-
porting_error) during the simulation run as well as a summary of occurred messages
at the end of the simulation run (reporting_summarize). All messages are sent to
the GUI and stored to a local file (transcript.txt). The GUI filters the messages
according to its needs.

4.12 Implementation

The OVM library1 is used to implement these functions. This choice has been done,
as the OVM library is a free and open source library based on SystemVerilog and is
supported by most of the EDA tools vendors. Furthermore this approach allowed us
to implement a reporting function in a short time, to have more time to concentrate on
the real verification parts of the TB. If needed, the implementation of these functions
can be replaced in a way to be independent of any library.
On a further action to be independent of precompiled libraries provided by the sim-
ulator vendors, the used source files are delivered with the testbench and compiled
on each testbench run, as seen in the simulation script excerpt below.

## compile ovm
vlib m2mOvm
vmap m2mOvm $Path/comp/m2mOvm
vlog -work m2mOvm +incdir+$srcSVPath/ovm/src

$srcSVPath/ovm/src/ovm_pkg.sv

Simulation script

Furthermore the simulation command had to be adapted to use the compiled OVM
library instead the precompiled one as shown below.

## compile project
#vlog -work $workPath $srcSVPath/M2M_harness.sv

$srcSVPath/M2M_tb.sv
vlog -work $workPath -L m2mOvm

$srcSVPath/M2M_harness.sv $srcSVPath/M2M_tb.sv
#vsim -vopt work.M2M_TB work.M2M_harness
vsim -vopt -L m2mOvm work.M2M_TB work.M2M_harness

Simulation script

On a nice side-effect, the furnished OVM source code has been altered such that mes-
sages wear the prefix M2M_ instead of OVM_ (see also 4.15).
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4.13 Format

The different fields of a message as shown in Table 4.3 are separated by space and
additional markers (please refer to 4.15). SystemVerilog provides the same severity
levels natively.

4.14 Examples

Below some examples for messages generated with the Reporting’s functions.

# M2M_INFO ../src_SV/bases.sv(181) @ 0: tb [tb]
Constructed tb

# M2M_INFO ../src_SV/objection.sv(313) @ 0:
AUTO_FINISH [objection.AUTO_FINISH] Objections to
AUTO_FINISH from tb.M2M_in_comp.stim_gen: new peak
= 2

# M2M_INFO ../src_SV/M2M_input_classes.sv(435) @
50345: driver [tb.M2M_in_comp.driver] task
tb.M2M_in_comp.driver.get_stim finished

# M2M_ERROR ../src_SV/M2M_checker.sv(259) @ 775: check
[tb.check] Bad DUT output no. 1.4956: M2M_Out_Trans
: Result = 0xbe3247ea = -0.174102 expected:
M2M_Out_Trans : Result = 0xbe3247e6 = -0.174102

Examples

4.15 Summary

The following summary is generated at the end of the simulation run. It shows the
number of messages grouped by severity level and by ID.
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# --- OVM Report Summary ---
#
# ** Report counts by severity
# M2M_INFO : 4643
# M2M_WARNING : 0
# M2M_ERROR : 457
# M2M_FATAL : 0
# ** Report counts by id
# [objection.AUTO_FINISH] 13
# [tb] 3
# [tb.M2M_in_comp] 3
# [tb.M2M_in_comp.driver] 59
# [tb.M2M_in_comp.monitor] 3
# [tb.M2M_in_comp.stim_gen] 4
# [tb.M2M_out_comp] 3
# [tb.M2M_out_comp.monitor] 2
# [tb.check] 5003
# [tb.timing_check] 7
Questa verification finished

Summary
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Name Type Description

M2M_Bus_Size integer

NUMBER_OF_INPUTS integer number of inputs of the Octave
function

NUMBER_OF_DUT_INPUTS integer number of inputs of the DUT

READ_INPUT_WAY bit[1:‘NUMBER_OF_INPUTS] the way to read data when the
input is a vector (not used now)

INPUT_PARALLEL bit[1:‘NUMBER_OF_INPUTS] array with a size equal to
NUMBER_OF_INPUTS, which informs if
an input is built in parallel (1) or
in serial(0) in the DUT

NUMBER_OF_OUTPUTS integer number of outputs of the Octave
function

NUMBER_OF_DUT_OUTPUTS integer number of outputs of the DUT

READ_OUTPUT_WAY integer the way to read data when the
output is a vector (not used
now)

OUTPUT_PARALLEL bit[1:‘NUMBER_OF_OUTPUTS] array with a size equal to
NUMBER_OF_OUTPUTS, which informs
if an output is built in parallel
(1) or in serial (0) in the DUT

CLOCK_TICKS integer number of simulation time ticks
during one clock cycle used in
harness to generate the system
clock used in checker to calcu-
late clock timings

NUMBER_OF_INTERNALS integer number of internals of the Oc-
tave function

NUMBER_OF_DUT_INTERNALS integer number of internals of the DUT

INTERNAL_PARALLEL bit[1:‘NUMBER_OF_INTERNALS] array with a size equal to
NUMBER_OF_INTERNALS, which in-
forms if an internal is built in
parallel (1) or in serial (0) in the
DUT

Table 4.1: Testbench parameters
Math2mat User Manual c©HES-SO // ISYS



90 CHAPTER 4. VERIFICATION

Indicator Measure Calculation Remarks

Total Input Time First input to last
input

- -

Input Rate - TotalInputTime/
(NumberOfInputs-
1)

Average time be-
tween two data in-
puts

Latency First input to first
output

- For a future ver-
sion, the average
latency of all in-
put/output pairs
could be measured
and calculated

Total Calculation
Time

First input to last
output

- Total time the DUT
is processing data

Table 4.2: Timing monitor statistics

Field Description

Severity Can be Error or Info/Warning
Tag Depending on the severity: M2M_ERROR or M2M_INFO
File name of the file the message originates from
Line line in the file the message originates from
Time simulation time in simulator time units
ID name of the object the message originates from
Message refer to examples in 4.14

Table 4.3: Simulation message format
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